Graphing Exercise 1. Create a Pie Graph by Selecting a Data Table

This exercise selects the data in an existing data table and creates a pie graph of the data (Figure G1-1).

Figure G1-1. Tree species sampled in schoolyard phenology study at Athol-Royalston Middle School, 2004-2007.

Summary of Steps to Create Pie Chart Using Data Selected From a Spreadsheet Table

1. Input a new data table of tree-species data into your worksheet.
2. Select both columns of Tree Species data in the table you created.
3. Instruct the computer to insert a pie graph.
4. Format and edit the completed graph as you choose.

Educational Goals of Exercise

Become comfortable with working within a spreadsheet to:
- Select data you want to graph
- Choose a graph type for your data
- Create a graph
- Format the graph
- Consider the mathematics involved in creating a pie chart
Detailed Step-by-step Instructions for Creating a Pie Graph by Selecting a Data Table

Step 1. Open a new worksheet in Excel. Create a data table by typing in the data in Table G1-1. Title the columns as in the table.


<table>
<thead>
<tr>
<th>Tree Species</th>
<th>Number of Trees</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beech</td>
<td>2</td>
</tr>
<tr>
<td>Chestnut</td>
<td>2</td>
</tr>
<tr>
<td>Hawthorn</td>
<td>1</td>
</tr>
<tr>
<td>Red Maple</td>
<td>4</td>
</tr>
<tr>
<td>Witch Hazel</td>
<td>1</td>
</tr>
<tr>
<td>Yellow Birch</td>
<td>1</td>
</tr>
</tbody>
</table>

Step 2. Select the tree species data table you just typed in, including the column headings.

- Highlight the seven rows and two columns that contain the column headings, species, list, and numbers of individuals.

Step 3. Use the Insert Chart command to select a pie graph (Figure G1-2).

Different versions of Excel do this in different ways; figure out which option(s) your computer provides.

- Click on the Insert chart icon on the toolbar, if present, choose the Pie graph option, and select the simple pie graph icon.

OR

- Select Chart on the Insert menu, choose the Pie graph option, and select the simple pie graph icon.

OR

- Click on the Pie icon in the Charts group under the Insert tab, and select the simple pie graph icon.
Figure G1-2. Examples of different Excel commands for inserting a pie graph.

Top: Insert Chart command on toolbar menu and Chart Type dialog box. Arrows identify an optional Insert chart icon on toolbar, the Insert Chart command on the dropdown Insert menu, and (at right) the Pie graph options on the Chart Type dialog box.

Bottom: Pie graph icon and dialog box in Charts group, Insert tab. Arrows identify an optional Insert chart icon on the Quick access toolbar, the Insert Chart command on the dropdown Insert menu, and the Pie graph options on the Chart Type dialog box.
Step 4. Format the graph, inserting a graph title, adding data labels to the pie slices, and changing the color of the sections. Again, formatting details vary with Excel versions. You can generally find the commands you need on the tool bar or in a drop-down menu when you click on different parts of the graph. See the separate handout on formatting for more information on how to format graphs using Excel.

1. Give your graph a title. Find the “Chart Title” command, choose an option for the location of the title, and type in a title for the pie chart (e.g., Number of Trees of Each Species in ARM Schoolyard Phenology Study).

2. Practice adding and removing data labels from your pie chart. Find the “Data Labels” command, and choose an option (in Figure G1-1, on the first page of this exercise, Outside End was selected). Try other choices to see how they appear on the graph. Explore having the tree species and the number of trees listed, as well as just the tree species or the number of trees.

3. If you wish, play with commands to adjust the location and appearance of the “Legend” to see their effects on the graph.

4. Look at Format options to practice changing the color of the pie slices, the background surrounding the pie, the overall graph background, and the borders of the graph.

When you have finished, you should have a pie graph that is similar to that in Figure G1-1, with your own (optional) variations on the color scheme, font, and graph title.

Step 5 (optional). Reverse the order of steps 1 and 2, inserting the pie chart first, and then selecting the data. How does the result differ from the original exercise?

NOTE: You can also create a stacked bar graph using the same steps for graph creation as in the pie-graph exercise. Try the following steps, just for practice, before moving to Graphing Exercise 2, which creates a stacked bar graph using the Data Source dialog boxes.

1. Select the Tree Species data table, as above in Step 1.
2. Instead of inserting a pie graph, select a stacked bar graph under the Insert Chart, Chart Type option. Be sure you select a simple stacked column, and not one that is adjusted to 100%
3. If your result looks strange and is not what you expected, be sure the data are listed as being in rows instead of columns. You may need to choose Switch Row/column to get a stacked bar, instead of a line of individual bars (we will make the individual bar graph in Graphing Exercise 3).
4. Format and edit as in the pie-graph exercise to end up with a graph comparable to the stacked bar graph in Graphing Exercise 2.
5. Sort the data table by Number of trees, instead of alphabetically, and look at what happens to the graph.
Graphing Exercise 2. Create a Stacked Bar Graph Using the Source Data Dialog Boxes in Excel

This exercise introduces the Excel Source Data dialog boxes. These dialog boxes allow you to specify the data that you are going to graph very precisely. This is useful – and necessary – when you have a complex data set, or if you want to graph only a portion of your data. In this exercise, you will practice using the Source Data dialog system with the simple data table you used for the pie chart. Once you are familiar with the Source Data dialog boxes, it will save you time in creating more complex graphs of data on leaf fall, bud burst, water-level changes, hemlock woolly adelgid infestation, changing forests, and other field variables you and your students measure over time for schoolyard ecology studies.

For this exercise we will graph the same tree-species data as in the pie graph in Graphing Exercise 1, but we will use the Source Data dialog boxes to specify the data we will be using to create a stacked bar graph, as in Figure G2-1.

Figure G2-1. Trees sampled in fall phenology study by students at Athol-Royalston Resional Middle School, 2004-2007.

Summary of Steps

1. Click on a blank cell in your Excel worksheet.
2. Tell the computer to insert a graph, and select the type of graph you want to create.
3. Use the Data Source dialog box to select a data range for graphing from a data table.
4. Use the Data Source dialog box to specify individual data to be graphed, creating a series.
5. Format/edit the graph, as appropriate.

Educational Goals

• Practice, and become comfortable with, specifying data to be graphed using the Excel Data Source dialog boxes.
Step-by-Step Instructions for Creating a Stacked Bar Graph With the Select Data Tool

Step 1. Open the worksheet with the Tree Species data table. Click on a blank cell. This can be anywhere in your Excel worksheet.

Step 2. Tell the computer to insert a graph, and select the type of graph you want to create. NOTE: Excel uses the term Column chart for vertical bar graphs, and Bar chart for horizontal bar graphs. For this exercise, you will select a stacked column.

1. Click on the Insert Chart icon, or go to the Insert menu on the toolbar and select Chart

2. In the Chart Type dialog box that appears, click on the Column icon, and select the stacked bar based on the actual numbers in your data (the icon shows two stacked columns of different heights; compare with the example with equal columns, which standardizes the data to a percentage value).

3. Click on Next or OK.

   • On some computers, a dialog box with Source and Data in its title will appear.

   • If a blank chart frame appears on your spreadsheet, you can access the Select Data (or Source Data) dialog box as follows:

      1. Click on the blank frame on the spreadsheet

      2. Right-click in the blank chart frame and choose Select Data (or Source Data) from the pop-down menu that appears

      OR

      3. Click on the blank frame on the spreadsheet, go into the Design tab under Chart Tools, and choose Select Data (or Source Data).

Step 3. Go into the Data Range dialog in the Source Data box, and select the data you wish to graph from the spreadsheet.

1. Depending on your Excel version, you may need to change the setting that appears initially in the Source Data dialog box. If you see a dialog box labeled “Chart Data Range” go to Step 2 (see Fig G2-2 for examples). Otherwise, look for the words “Data Range” and “Series” in the Source Data box, and select “Data Range.”

2. Place your cursor in the Data Range dialog box. Click in the box, and then select your data table in the spreadsheet. The coordinates of your data in the spreadsheet will appear in the box, and a graph will appear on your screen or in the Source Data dialog box.
• If the graph that appears is a series of individual bars, and not a stacked bar chart, go into the Source Data dialog box and click on Switch row/column; the stacked graph should appear. (If you have the stacked bar chart to start with, switching rows and columns will produce individual bars for each tree species.)

Figure G2-2. Two Versions of Source Data Dialog Boxes in Excel

In this version, both the Data Range and the Series dialog options are found together.

In this version, you need to switch between Data Range and Series dialog boxes
Step 4. Go into the Series dialog area in the Source Data box, and specify the data you
wish to graph as a series, by year.

(1) Click on Switch Row/Column again, and remove the coordinates
from the data range box on the Data Source form.
(2) Click on “Add” on the left side of the Data form; click your cursor in the
“Series Name” box, and then go to your data table and click on the first tree
species on your list.
(3) Remove any information that may be in the “Series Value” box, click your
cursor in the box, and then move the cursor to the number of individuals value
for tree species 1 in your data table.
(4) Click OK or Next, and the first tree species name and the number of
individuals should now appear in the Select Data Source box. A bar with a
single color, representing the number of trees in species 1, will appear on your
screen or in the dialog box.
(5) Repeat steps (2) through (4) for all of the tree species in the table (for this
exercise, you will go through these steps six times, for the six tree species
listed in the spreadsheet table). With each addition, you should see the stacked
bar graph grow on in the chart frame on your spreadsheet.
(6) When you are done, click OK or Next.

Step 5. Format/edit the graph.

(1) As you did for the pie chart, provide a Title for your stacked bar graph, decide how
to present the labels identifying the different tree species, and adjust the colors.
(2) Depending on the units that Excel chooses to display, you may find it necessary to
adjust the scale on the Y axis. The best way to adjust scale involves the following
steps:
• Right click on the Y axis, and select “Format Axis” from the dropdown menu that
  appears.
• Select “Scale” and specify an interval that is a whole number – there are no half
  trees in the study.
• You may also want to change the maximum value on the Y axis.
Graphing Exercise 3. Creating a Simple Bar Graph from an Existing Graph

This exercise uses the Chart Type dialog box and the Switch Rows/Columns commands to convert an existing graph into another kind of graph. You will convert the pie chart and the stacked bar graph created in Exercises 1 and 2 into simple bar graphs, as shown in Figure G3-1.

Figure G3-1. Two versions of simple bar graphs produced from the pie graph and stacked bar graph.

Left, graph produced by specifying that data are in rows.

Right, graph produced by specifying that data are in columns.

Summary of Steps

1. Select an existing graph.
2. Use the Change Chart Type dialog box and/or the Source Data dialog box to convert the graph into a simple bar graph with a separate bar showing the number of individuals sampled for each species.
3. Edit the graph as needed.

Educational Goals of Exercise

- Develop facility with using the Switch Rows/Columns command, the Change Chart Type dialog, and the Source Data dialog boxes, to change an existing graph into another kind of graph.
Detailed Instructions for Creating a Simple Bar Graph From an Existing Pie Graph

Step 1. Select the pie graph you created in Graphing Exercise 1, and go into the Chart Type dialog box.

- Right-click on the pie chart, and select Chart Type from the drop-down menu that appears

OR

- Select the pie chart by clicking in the frame (as opposed to a specific part of the graph), and then go to the Chart Type dialog box on the toolbar or under the Chart Tab at the top of your screen.

Step 2. In the Chart Type dialog box, select Column, and then click on the simple bar option (as opposed to a stacked bar).

The pie graph on your screen should disappear and be replaced with a graph consisting of a series of individual bars, one for each species in the sample, as in the right-hand example in Figure G3-1.

Step 3. Change the Data Source information to specify that the data are in rows instead of columns.

- Right-click on the graph, select Source Data from the drop-down menu, and click on Switch Rows/columns to specify that the data are in rows.

OR

- Select the graph by clicking on it, go to Source Data on the toolbar or in the Design tab, and click on Switch Rows/columns to specify that the data are in rows.

The graph on your screen should now appear as individual bars, each colored as in the original pie graph, as in the left-hand example in Figure G3-1.

Detailed Instructions for Creating a Simple Bar Graph From an Existing Stacked Bar Graph

Step 1. Select the stacked bar graph you created in Graphing Exercise 2.

Step 2. Use the Chart Type dialog box and the Source Data dialog box to change the pie graph into a bar graph, as you did for the pie graph, above.

You will find that selecting the simple bar graph icon in the graph sub-type dialog results in a bar graph that has the individual species shown as separate bars, with each bar colored individually as in the stacked bar graph, as in the left-hand example in Figure G3-1.
Step 3. Change the Data Source information to specify that the data are in columns instead of rows, following the steps you used for the pie chart, above.

Specifying that the data are in columns produces a graph with all bars the same color, and with the species labels on the X axis, as in the right-hand example in Figure G3-1.

Figure G3-2. Sample commands for specifying whether data are in rows or columns.

Left: Source Data dialog box specifying that data are in columns, from Excel 2000.
Right: Switch Row/Column command in Data group on Design tab, Chart Tools, in Excel 12.
Graphing Exercise 4. Graph Leaf-Fall Data from One Tree

This exercise will graph leaf fall from a single tree over four years of sampling. The graph will be similar to Figure G4-1.

Figure G4-1. Progression of leaf fall in a yellow birch sampled in 2004-2007 by students at Athol-Royalston Middle School.

For this exercise, we will use data for the first tree in the Athol-Royalston Middle School (ARM) Schoolyard data set, a yellow birch, which we will abbreviate as YB1. We will convert the leaf-fall data into percentage of leaves fallen, and then use the Source Data dialog boxes in Excel to specify the data that are to be graphed in a scatter plot. The data points will be connected with a line to show the pattern of leaf fall during the sampling period.

Summary of Steps

1. Download fall data from Athol-Royalston Middle School (ARM).
2. Organize the data by tree, so each tree’s data are presented chronologically, together.
3. Add a new column to the data with percent of leaves fallen.
4. Insert a graph, specifying that you want a scatter plot without lines connecting the points.
5. Use the Source Data dialog boxes to add the leaf-fall data from 2004, 2005, 2006, and 2007 (you may add data from later years, if you wish).
6. Edit the graph, as appropriate.

Educational Objectives of Exercise

- Review and practice sorting data in an Excel spreadsheet
- Learn how to convert count data in a spreadsheet to percentages
- Become comfortable with using the Source Data dialog to create a complex graph.
- Increase confidence in formatting the graph to produce a clear presentation of the results
- Further develop skills in interpreting the message the graph provides.
Detailed Step-by-step Instructions for Converting Count Data to Percentages in an Excel Spreadsheet

Step 1. Go into the Harvard Forest Schoolyard Database, and download the fall data from Athol-Royalston Middle School (ARM). Save the file on your desktop as an Excel file named ARMdata.

Step 2. Sort the ARM data by TreeID.

(1) Select the full data set by clicking in the diamond-shaped symbol or small box at the top left corner of the spreadsheet. The full spreadsheet should be highlighted.

(2) Go to the Data tab or symbol at the top of your screen, and select “Sort.” In the dialog box that appears, check the box indicating that your list has a Header Row, and in the Sort by box, specify Tree ID, ascending.

(3) Click OK, if necessary.

The spreadsheet should now be sorted by individual trees, with all of the data for each tree presented in chronological order. The first tree listed is a yellow birch, and you will work with data from this tree for this exercise.

Step 3. Add a new column to the worksheet, and calculate the leaf-fall data for each date as a percentage of the total leaves that have fallen.

(1) Examine the sorted ARM data. Rows 2 through 31 of the data table should have the 2004-2007 leaf-fall data for tree #1, a yellow birch (tree species code YB).

(2) Insert a new column next to the Fallen Leaves column. Title it “% Fallen”

(3) Place your cursor in the top empty cell of the new column (this should be cell I2), type in an equal sign (=), and then move your cursor to the left into the Fallen Leaves column and click; Cell I2 should now read “=H2”

(4) Go back into I2 and type in”/” (divide sign), and then move the cursor into cell G2; I2 should now read “=H2/G2”

(5) Hit ENTER; cell I2 should now read 0.

(6) Select cell I2; format as a percent by clicking on the % sign on your toolbar (often under the Home or Edit Tab, depending on your Excel version), OR by going into Format, choosing “Number,” and selecting percent; cell I2 should now read 0%.

(7) Copy cell I2 (use keyboard command Control C (PC) or Apple C (Mac) or use the Copy command on the taskbar, usually under the Home or Edit tab, depending on the Excel version you have).
(8) Select the remaining cells I3 through I31, and paste the copied I2 information (actually, the formula for calculating % fallen leaves) into them. The cells will now show the percent value for leaf-fall for all four years from 2004 to 2007. (Note: You can select more of column H, including later years of data for tree YB1, and all other trees in the study, if you wish, and calculate the % Fallen data for all of them.)

(9) If you click on any cell in column I that shows % fallen data, you will see that the cell is showing a calculation, not a number. Convert the calculation to a number as follows:

- Select the entire column, including the title (click on I at the top of the column)
- Copy the selected column (same command as used for copying cell I2)
- Use the “Paste Special – values” command to replace the calculation formula with the % value that has been calculated

Now, if you click in any cell in column I, you will see that it is showing a number, expressed as a percent, and not a formula.

You are now ready to start preparing your scatter plot graph.

Detailed Step-by-step Instructions for Using Excel to Graph Four Years of Leaf-Fall Data from Tree YB1

Step 1. Click on a blank cell anywhere in the worksheet with the ARM leaf-fall data.

Step 2. Instruct the computer to insert a graph, as in the earlier exercises, but this time specify that you want to create a scatter plot of the data, with points connected by straight lines.

(1) Click on the chart icon on the toolbar, or click on Insert Chart on the Edit menu on the toolbar, or select Chart under the Insert Tab on your computer, as before.

(2) Select X Y (Scatter) plot; you will see several examples of subtypes of scatter plot to choose from.

(3) For this exercise, click on the option that shows data points connected by straight lines, and click Next or OK.

Step 3. Go into the Source Data dialog box, and add the leaf-fall data for each year, entering the data as a set of series, using the Series tool.

(1) Click on the Add button in or next to the Series [Legend Entries (Series)] dialog box. “Series 1” will appear in the box in some versions of Excel; you will be directed to a separate “Edit Series” dialog in others.

(2) In the Name [Series name] space in the dialog box, type “2004.”
(3) Move your cursor into the X values box of the Series dialog. If there is anything in the box, highlight it and delete. Go to the sorted ARM Data Worksheet, and select the cells in the Day of Year/Julian Day column for 2004 for tree YB1 (cells D2-D8). The cell locations will appear in the X values box.

(4) Move your cursor into the Y values box. Highlight the contents and delete. Go to the YB1 Data Worksheet, and select the cells in the % Fallen column for YB1 in 2004 (cells I2-I8). The cell locations will appear in the Y values box. Click on OK in the Edit Series box or hit Enter to return to the main Source Data dialog box.

A version of a graph showing the 2004 data should appear on your screen. NOTE: If there is an extra line on the graph, look at the Source Data box – there will probably be an extra Series that Excel added on its own. Select this and delete it, and the graph will show only the 2004 leaf-fall data.

(5) Repeat steps (2)-(4) for 2005: click on the Add button, type “2005” in the Series Name box, add the YB1 2005 Day of year and % Fallen data in the X and Y boxes, and hit Return/Enter/OK.

The graph on your worksheet will now have two lines, one for 2004 and one for 2005, and the legend will list both years.

Fig. G4-2. Examples of Source Data Series Dialog Boxes for Adding Data to a Graph.
(6) Click on the Add button again, and repeat (2), (3), and (4) for 2006, typing in “2006” as the Series name, and selecting the 2006 Day of Year data and % fallen data. The graph now has three lines.

(7) Repeat for the 2007 data, and click on OK in the Source Data dialog box.

(8) OPTIONAL: If you wish, add the 2008 and 2009 data, and see two more lines appear on your scatter plot.

**Step 4.** Format/edit the graph, adding titles to the axes and to the chart, changing shapes and colors of data points and lines, adjusting the scale on the axes, and adjusting the X axis so that it will present the sampling dates in month-day format instead of as Julian day.

Figure G4-3. Examples of “Format Axis” dialog boxes.

Top Left: Axis Options dialog for adjusting the scale of the X axis to cover the sampling period instead of a longer time span. Top Right: Number dialog for specifying that the axis represents a date that is to be presented in a numerical month/day format. Bottom: Scale dialog tab for adjusting scale of Y axis so that maximum will be 100% instead of 120%. 
Graphing Leaf-Fall Data by Selecting a Data Table

It is also possible to graph data such as the leaf-fall data for a single tree, or for multiple trees, by creating a data table, selecting it as we did for the pie graph in Exercise 1, and inserting a graph. However, with multi-year data such as those we have from the phenology study, creating the appropriate table requires some effort. Table G4-1, below, illustrates the data table that would be used to create the graph shown in Figure G4-1. You may want to experiment with creating such a data table, selecting it, and inserting a scatter plot. You may also want to try simply copying the data for sampling dates and % of leaves fallen, putting them into a two-column data table, and seeing what happens when you select these data and insert a graph. It should be evident that using Source Data dialog box, especially for large and complex data sets, is much simpler than setting up separate tables for each graph!

Table G4-1. Data Table for leaf-fall from tree YB1, 2004-2007.

<table>
<thead>
<tr>
<th>Date</th>
<th>Day of year</th>
<th>2004</th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/22/2004</td>
<td>266</td>
<td>0%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/29/2004</td>
<td>273</td>
<td>0%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/6/2004</td>
<td>280</td>
<td>0%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/13/2004</td>
<td>287</td>
<td>0%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/19/2004</td>
<td>293</td>
<td>0%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/27/2004</td>
<td>301</td>
<td>0%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11/4/2004</td>
<td>309</td>
<td>100%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/28/2005</td>
<td>271</td>
<td></td>
<td>13%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/5/2005</td>
<td>278</td>
<td></td>
<td>13%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/12/2005</td>
<td>285</td>
<td></td>
<td>33%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/19/2005</td>
<td>292</td>
<td></td>
<td>42%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/26/2005</td>
<td>299</td>
<td></td>
<td>54%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11/2/2005</td>
<td>306</td>
<td></td>
<td>83%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11/10/2005</td>
<td>314</td>
<td></td>
<td>100%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/20/2006</td>
<td>263</td>
<td></td>
<td>8%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/27/2006</td>
<td>270</td>
<td></td>
<td>33%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/4/2006</td>
<td>277</td>
<td></td>
<td>46%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/11/2006</td>
<td>284</td>
<td></td>
<td>67%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/18/2006</td>
<td>291</td>
<td></td>
<td>71%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/25/2006</td>
<td>298</td>
<td></td>
<td>75%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11/1/2006</td>
<td>305</td>
<td></td>
<td>96%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11/8/2006</td>
<td>312</td>
<td></td>
<td>100%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/12/2007</td>
<td>255</td>
<td></td>
<td>17%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/19/2007</td>
<td>262</td>
<td></td>
<td>17%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9/26/2007</td>
<td>269</td>
<td></td>
<td>38%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/3/2007</td>
<td>276</td>
<td></td>
<td>54%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/10/2007</td>
<td>283</td>
<td></td>
<td>83%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/17/2007</td>
<td>290</td>
<td></td>
<td>88%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/24/2007</td>
<td>297</td>
<td></td>
<td>96%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Graphing Exercise 5. Graph First and Last Leaf-fall Dates

In this exercise, we will compare the first and last dates when leaves were observed to fall from Yellow Birch #1 during the four years of the study. The graph you create will reproduce Figure G5-1. To create this graph, it is necessary to create a new data table with the first and last leaf-fall dates for tree YB1, organized by year.

Figure G5-1. First and Last Dates of Leaf Fall in Yellow Birch #1, 2004-2007.

Summary of Steps

1. Create a new Data Table showing dates of first and last leaf fall
2. Select the data table
3. Insert a graph, and format as necessary.

Educational Goals for Exercise

- Become comfortable with manipulating schoolyard data to extract additional information from the original field results
- Explore multiple ways of graphing data on first and last dates of observed leaf fall over multiple years
- Practice reformatting axes to present time in different ways
Detailed Instructions for Graphing First and Last Leaf-fall Dates in Yellow Birch #1

Graphing the Data as a Scatter Plot

Step 1. Create a New Data Table

(1) Go back to the YB1 DataTable worksheet. To the right of the data on % Remaining, create a new table with three columns. In the top row, title the table First & Last Leaf Fall. Title the columns Year, First Leaf Fall, and 100% Fallen.
(2) In the first four empty cells in the Year column, type in 2004, 2005, 2006, and 2007.
(3) Look at the data in the % Fallen data table, and identify the first date in each year when leaves were observed to have fallen from tree YB1. Enter the date in the First Leaf Fall column. Use the Day of Year values.
(4) Go back to the % Fallen table, and find the date in each year when 100% of the leaves had fallen. Enter the values in the 100% fallen column. The data table should look like Table G5-1.

Table G5-1. Data Table for first and last leaf-fall dates for tree YB1, 2004-2007

<table>
<thead>
<tr>
<th>Year</th>
<th>First leaf fall</th>
<th>100% Fallen</th>
</tr>
</thead>
<tbody>
<tr>
<td>2004</td>
<td>309</td>
<td>309</td>
</tr>
<tr>
<td>2005</td>
<td>271</td>
<td>314</td>
</tr>
<tr>
<td>2006</td>
<td>263</td>
<td>312</td>
</tr>
<tr>
<td>2007</td>
<td>255</td>
<td>304</td>
</tr>
</tbody>
</table>

Step 2. Select all the cells in the Data Table, including the column headings.

Step 3. Graph the data as a scatter plot and format the graph as appropriate

(1) Following the steps you carried out in Exercise 4 insert a chart, and select X,Y Scatter Plot. Choose the version that has points, but without lines connecting them. HINT: You may have to adjust the command that specifies whether the data are in Rows or Column.
(2) Format the graph, following the steps you carried out above with the graph creation dialog boxes or with post-creation formatting commands. Adjust the Y-axis scale, insert titles for the X and Y axes, etc. Use the Format Data Series command to increase the size of the 2004 First leaf fall label so that it can be seen behind the 100% Fallen data point.

Your graph should look somewhat like Figure G5-1, with your own choices of symbols, colors, etc.
Graphing the Data as a Bar Graph

In Figure G5-2, the data in Figure G5-1 are graphed as a bar or column graph comparing matched pairs of data. As with the initial scatter chart that simply presented the data as points, it is easy to see how the dates when the students observed the first fallen leaves became earlier each year over the four years for which data are available. The similar but less consistent trend in the date of last leaf fall is also visible.

If you wish, use the Chart Type to change the scatter plot into a bar graph. Select the vertical bar graph (column chart) option and choose the simple bar graph sub-type that shows pairs of bars next to each other.

Again, adjust the Data commands and play with the formatting until you have a graph that satisfies you.

Figure G5-2. First and last dates of leaf fall in Yellow Birch #1, 2004-2007.